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Aim of the lecture

Introduce the parameters of the simulation software Plant Simulation 16.
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Structure of the lecture

Basic menu of PS.
File types, automatic saving.

Default settings of PS:
Units, modelling, icons.

Graphics of PS:
Icon editor, icon animation, creating of the conveyors.

Attributes.

Computer Simulation of Logistics Processes, SAU, Jan Fabry, 15/03/2023



Plant Simulation Parameters

Menu File

Menu “File” is used for basic operations

File

Recent Files

1 1. cviko.spp

2 Modell.spp

with the model file:

Opening.
Closing.

. 3 7. cviko.s
Closing - PP

of the model

Last opened files

i

Saving

of the model

Saving.

We can continue with:

&f Teamcenter »

O\I Compare Model Files

Manage the settings of the current
model and the parameters of the
entire PS.

Create files that can be initiated
without PS license (presentation
purposes).

Model sharing

Model encryption
settings

Settings of
the current model

Options

‘?’_“] Model Settings

PS parameters
Help

Exit the PS

E Exit
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Types of files — opening of the models

Opening of existing file through the option “Open” in the “File” menu (1).
Plant Simulation usually works with *.spp (2) files.

It can also work with *.bak (2) files.

File I Oteviit
j MNew Recent Files — v 4 « B semestr » Simulace LGA * Cviceni w O S Prohledat: Cviceni
, 1 1. cviko.spp +H
Uspofadat = Nova slozka = ~+ [
l Open I 2 Modell.spp = ° i e
- Nazev Typ Velikost
-
37 cvik.spp 5 Rychly piistup
-] 1. cvigeni.spp Plant Simulation ... 426 kB
@ OneDrive - SKODA AUTO 8§ 2. cvigenispp Plant Simulation ... 438 kB
& Tento poéitac !] 3. cvicenispp Plant Simulation ... 451 kB
-] 4. cviceni.spp Plant Simulation ... 426 kB
@ sit !] 5. cviéenispp Plant Simulation ... 793 kB
H] 7. cvicenispp Plant Simulation ... 856 kB
é), Teamcenter » !] 8. cvicenispp Plant Simulation ... 825 kB
!] 9. cviceni.spp Plant Simulation ... 521 kB
!] 6. cviceni.spp Plant Simulation ... 1288 kB

% Share »
‘ Nazev souboru:; |

— )
%— | Options »

Model Files (*spp)
Model Files (*spp)
Object and Library Files (*.psobj; *lib)
Backup Files (*.bak)
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Types of files — models saving

Model can be saved by buttons (1) or in the standard
menu:

File — Save Model.

File — Save Model As.

Plant Simulation creates file with suffix *.spp for the first
model saving.

After that, Plant Simulation saves all the upcoming
changes into this file (*.spp). At the same time, PS
renames the previous version of this file and stores it in the
backup file with suffix *.spp.bak.
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Automatic file saving

In the PS direct option of automatic file saving after some
pre-set time (not in the running PS) does not exist.

Saving has to be done manually during the work — do not
forget about it!!!

This indirect option might help:

In the attributes of the shortcut, where the Plant
Simulation is launched, it is possible to set the
automatic saving in user’s predefined time interval.

It is necessary to write the path to *.exe file:
-a (syntax for auto-save)

1:00 (syntax for defined period between

the saving — in this case it is 1 minute). |00
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@#® Plant Simulation 16 - viastnosti

Zabezpeleni Padrobnost Pfedchozi verze
Obecné Zashupee Kompatibilita
N Plant Simulation 16
o
Typ cile Aplikace
Umisténi cile:  Plant Simulation|
Cil: I"F‘Iant Simulation\PlantSimulation.exe"-a 1:.00 I

Spustitv

Kldvesova Fadné

zkatka:

Spustit W nagpdinim okné v
Komentaf: Starts Plant Simulation with the license type you selec

viit umisténi souboru Zménit ikonu.. Upfesnit. .

Zrusi Poulit
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Default settings — General

In the “File” menu under “Preferences” can be
made various settings for the entire PS program.

Model language can be modified in the tab
“General® (i.e., German, Japanese,...) as well as
the time format (12 or 24 hours) (1).

In addition, the setting allows user to enable or
disable the automatic connection of objects with
connectors (2).
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Preferences ? x
I General I Simulation  WUnits  User Interface  Editor 2D 3D License
a Model
Model language: |Eng|ish -
Date and time format: |m"_.rfmmj’dd 24 hour -
Model saving history: Mone -
~ Visualization Connector settings
(_) 2D only Connect objects automatically
() 3D only Positioning: Angle-dependent =
(®) Ask each time
[ | Create backup files with time stamp
Additional libraries
{ Libraries directories: ‘ |
8
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Default settings — Units

We can set the units of mass (weight), currency, Preferences 7 X
Speed’ acceleration or Iength in tab “Units“ (1) General  Simulation Iml User Interface  Editor 2D 3D License
Timeline scale can be also changed individually (2). (@) v ] paylight saving time

Mass: kg .

Currency: | Ke .

speed: [mis (mps) - e

Acceleration: |m,fsz (mps2) = Start: |3 : |'1 |: |D : |2 |

Length: m N End: |10 {1 |:[0  :[3 |

1w= |1 m .

Time scale

Time scale Transfer if: |24 |:|60 |: 60 |
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Default settings — 2D
Various display of the frame can be set in tab “2D". Preferences 7 X
This particu|ar Setting can be also Changed General  Simulation  Units  User Interface  Editor | 2D 30 License
individually in the frame itself. - Frame seftings
[v|:Show object names: [ | Show object borders
[ | Show MU names Show connections
[ | show object labels Show comments
Show display panels Show grid
[ | Show predecessors [ ] Show successors
Select objects Frame grid spacing
{ [ | Ignore transparent area ‘ Horizontal: [pixels]
Vertical: [pixels]

10
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Symbols and icons
It is possible to change location, orientation and size of objects and their icons in menu Icons.
However, for proper operation of the object in the frame, it must be activated (selected).
File Home Debugger Window General Vector Graphics ) Find a Command
o ~u - ) i —
> A 2IEEERNEN D G
Previous MNext Mirror Mirror Rotate Reset Align | Bring to Send | Double Original Half Inherit Inherit Size/
Horizontally Vertically to Grid | Front to Back Size Size Size Position Orientation
General Orientation Actions Size Inheritance
Class Library v+ 0 X Toolbox
/%BESiS Material Flow | Fluids ~ Resources Information Flow WUser Interface Mobile Units User Objects
| MaterialFlow o B s [ ey B e | = o B e Il |
Faids el CE- A I i R T C A P T
Resources

InformationFlow
Userlnterface
MUs
UserObjects
Tools

-1 Models

-5~ - - - - - -
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Names and labels of objects
Each object must have the Name and can have the Label.

By displaying the labels and hiding the names, you can show the descriptions for some objects
and hide them for others, which helps the model's clarity.

TX THEHME » G- Frame ame.sp

NoName.spp - Tecnomatix Plant Simulation 16 - [Models.Model1 (175%)]

o 5 = 2D| =28 Cut A5 Select All = = Controls E3 . —
:.‘_) WP W “|“|® g £ LCI@ c B & e N, M j £ @ I, ;_H-F = e O 0 £ . #TRibbon Tab 1] e
o MUsand  Open O Open O Past Gicopy | FRename Jcons Displ D B Ooserver Attrbutes Statisics | Sructure I il o — AR o - | & Context Menu - ums l_‘E
pen | -~ ———{ + |MUsand | Open Gfign Chse 203D | = 2 Delete SgDeletemus | T SR e [R User-deined | Niaiiods Report Print  Find | Unconnected No Length | Zoom Original Zoom | Scaling Representation | _ Shift Background Replacement Names lonnections Comments Grid ~More
Object Objects Transfer In Size Out Factor Calendar - Mode¥ Structure
Event Controller Arimation Navigate Edit Objects
Actions Show Zoom Settings View Options MU Name
Class Library v & X Toolbox
- Class Library v 3 X Toolbox v Object Labels
A Basis Material Flow | Fluids  Resources Information Flow _User Interface Mobile Urnits _User Objects Tools 0 Bas | —
MaterialFlow L [ —— T — — = — — > It Basis Material Flow | Fluids ~ Resources Information Flow User Interface  Mobile Units User Objects  Tools v Display Panels
Fluids x 9 g | i R LR i @:' gas pea o § U = © @ T MaterialFlow or — s = T e j— o= -+ Predecessors
: = Tl= - : v Z Dy b BB GHEmEEERR =GO~ O &
Resources Rename a - Fluids —_ =S ea Bl o =2 — Y| — =5 Successors
InformationFlow [e R R Resaurcgs Object Borders
MUs — Interface =
.| UserObjects EventController 5
Tools erObjects
=+ | Models
£ Model (5/80) T 1 T 1 r 1
— e om0 .
£ Model1 (5/80) 5 Model (5/80) — — — —
— — L £ Modell (5/80) [+ 1+ o —— - - -+
Presshop Buffer1 Weldingshop Buffer2 Paintshop L 1 L 1 L 1 L 1
1 | e—
Presshop Weldingshop Paintshop
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Icons editor - usage

lcon editor allows graphical visualization of objects via selected pictures and their animation.

We can use own icons (not only the predefined) for displaying most of all objects in models. For objects of material
flow, MUs and frames is also possible to define animation points or lines for MUs visualization on specific objects.

It is also possible to use pictures in the background. We can use, for example, the layout of plant or production line,
which will be later transferred into compatible format with the Plant Simulation and paste it as the frame background.
The individual objects of the model are then placed on the exact locations as they are, or will be, oriented in reality.
This is useful for modeling of length-specified objects.

% , 13
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Appearance of the model using the icon editor

Production line
layout used as
the frame
background

Inserted
control frame
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Plant Simulation Parameters .

SKODA AUTO University
Icons editor

The icons editor is opened in the “Home" tab with the icon named “Icons®.
It is possible to keep the existing icons and assign a number of additional icons where the size can be changed, etc.

We can create an icon picture or insert file with a picture: File — Open (to choose required compatible file - *.gif,
*.bmp, *.ppm, *.dxf, *.dwg, *.ico) or use the function Drag&Drop to "move” a picture to the drawing area.

Number: 1/2 MName: Operational +| Current [
<[ =

RGB: 0, 128, 128

TX p H “ e W @ = Frame EllllIIIIIIIIIIIIIIIIIIIIIIE
| 1
i Window General lcons Wector Graphics Q Find a Command = =
"9":. o o 5 2 fg Select All .‘ o . I i I u
W & =]l Rename % Eg‘ E. 8
Open - + | MUsand Open Open Paste an lcons RDisplay N N
lcons Location 2D/3D - 57 Delete MUs Panel u u
Event Controller Arnimation Nawvigate Edit H t H
T I
Class Library v & X Toolbox H m
T : :
H H
- COrrr e T
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Movement of the
reference point

: : Drawing tools (lines, shapes,
Overview @ Pick Color filling, rubber)

Main window of the icons editor — “Edit“ tab

Saving of changes

MNoNafespp - Tecnomatix Plant Simulation 16 - [Models.Modgl.Station]

o X =P BV

Reference

E<re Debugger Window

: ¥
el BLNCNE 4 /&\\/\IOD @ &

Q Copy/Paste Area
& Paste Area

Cwverview | Zoom Zoom | Drawing Pick | Freehand Line Polyline Ellipse Rectangle Filled Fill - Delete Size  Transparent Inherit Apply
H Export In Out Color  Color Rectangle Area m Replace Color Point ¥ Changes
File Go To Zoom Actions Settings Inheritance | Apply
Toolbox

Material Flow | Fluids Resources Information Flow User Interface  Mobile Units  User Objects Tools

k ""'rljg P | = *l*%:]**ﬂ**ﬂ*p nllIllEqul—HOO O.:-E-

1 1 1 Number: 1/2 MName: Current D
Size of original e

Color palette

Transparent
color

it Reference point

Current color
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Main window of the icons editor — “Animation* tab

Overview Movement of the reference point

Saving of changes
- oMame.spp

Home Debugger Window Elit Animation General ¢ Find a Command

~ | - ERY4

L

pt m | ]

Overview | Zoom Zoom Point | Line Folyline| Move Delete Link Animation | Animation Inherit Apply
In Out All Events MNumbers Changes

GoTo Zoom Edit Settings Options | Inheritance | Apply

Toolbox

Material Flow | Fluids Resources Information Flow User Interface Mobile Units  User Objects Tools

Icon’s order

Scrolling all
created icons

| Current

lE>Number: 1/2 MName: | Operational _K

= T
| |

E I I Current cursor

location
]
-l;
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Frame animation

We can also assign custom icon to a frame. In the example below, in the model, Station object is replaced by a
separate frame. In the frame, the image is assigned to the icon with the name operational.

Toolbox Tzale: Number: 1/2 Name: Operational | Current O
Material Flow | Fluids ~ Resources Information Flow User Interface Mobile Units User Objects Tools Material Flow | Fluids  Resources Information Flow User Interface Mobile Units User Objects Tools zm < > (61. 1)
. E— o e e e = /e —_
VB E Y o BEBECHAREMEEREOO-EG P OF) I FEEECHRRPEIEO0-
5 | |
e =
L [
— ] |
1
_ I
m
I
| 1
.
/i
> o — @ Entry Station Bxit
Presshop Weldingshop Paintshop
Main model Nested frame Icon editor

. . . % , 18
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Ilcon animations

MU movement can be visualized by animation points, even in the hierarchical structure of frames (for frames inserted
into other frames).

These points represent the connection of the icon and the object that lies in the frame. MUs that are currently on the
object during the simulation run will appear on the corresponding animation point of the icon.

Depending on the object type, animation lines can be also assigned.
Setting of the animation points/lines is made in the “Animation” tab in the icons editor.

The animation points can only be assigned to class objects.

Window Edit Animation General } Find a Command

Home

Debugger

Toolbox

Material Flow | Fluids Resources Information Flow User Interface Mobile Units  User Objects Tools 1m
e | s B gy B ey Y ey | i1 — 7 hbd
Ve E > b A mEBEBGEH MBS E=EGO—~E T \ a 2o | /
e Overview | Zoom Zoom Point  Line Polyline § Move Delete Animation Inherit Apply
| = In Out All Numbers Changes

Settings Options Inheritance Apply

Go To Zoom

&

| amo- w1 ST Link to object
| — | M— | I_I  IS—
Presshop Paintshop

Weldingshop

Computer Simulation of Logistics Processes, SAU, Jan Fabry, 15/03/2023 9



Plant Simulation Parameters .‘

SKODA AUTO University
The process how to create a simple icon

First of all, we need to activate some of the animation tools, for example adding of the animation point.

Then click on the desired insertion point on the icon, where you want the animation to be visible.

Number: 1/2 Name: Current |:|
File Home Debugger Window Edit Animation General ¢ Find a Comr /‘ﬂ 5] (105, 1)

18w a
o e e [#N A XX ¥ 1 1= B
Owverview | Zoom Zoom Line Polyline | Move Delete Link Animation | Animation Inherit
In Out All Events Numbers
Go To Zoom Edit Settings Options | Inheritan
||
.|
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The process how to create a simple icon

Activate the animation point link tool. Click on the animation point, this will automatically open the frame for which you
are editing the icon.

Click on the animated station (Station). If we have more stations in the frame, we can repeat this process for them.

We will ensure that the button Current is active (it means that this icon will be used). It is even possible to change the
icon’s name.

All the changes must be saved by “Apply Changes”.

Number: 1/2 Name: Operational Current O Toolbox
Debug g =1 WIndDw Ed |-t '.'fl,'r-”m Elticlrl [::I m (105, 1) Material Flow | Fluids  Resources Information Flow User Interface Mobile Units User Objects Tools
e Ve B Z ) b EERECHEAREEREOO -
]
N A t 1 o

Point  Line Polyline| Move Delete Link Animation | Animat
All Events Numb = =1
L : o my ) o »
Edit Settings Optiol oy ISZ‘_II r

. 21
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Icons editor — additional information

In case that we are creating custom icons (not inserting pictures), we use drawing tool from the toolbar in the
editor menu. We can draw freehand, straight lines, polylines, ellipses, rectangles, filled rectangles, we can fill
areas with color, or we can copy areas and paste copies of them.

Pick Color - this tool is used for color selection from a drawing area. The picked color will be then selected as the
active color on the drawing area.

The reference point is used to determine the position of the used object icon in the frame and to represent MUs on
this object (example - during the animation, the Station reference point coincides with the reference point of the
mobile unit that is currently inside the object). By default, the reference point is located 20x20 pixels from the top
left corner of the icon.

. . . % , 22
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Icons editor — additional information

Transparent color — if we use the transparent color in the icon’s desktop, it means that on that particular spot the icon
will be "transparent” and the frame background will be visible.

The currently used icon has the Current check box enabled.

Maximal size of an icon is 4000x4000 pixels.

If we name an icon as background, picture will be used on the frame background.
Use of the user-defined icons and their animation slow down the simulation run.

It is possible to switch automatically icons in case they have special names (working, setUp, no Entry, failed, pause,
waiting).

If you don't want the object icons to change, you must rename these icons (they must not have any of the special
names) or delete them.

% , 23
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Conveyor creation
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Conveyors can be modelled very realistically by inserting a sequence of curves and straight segments into the model. The
length is set according to the layout (according to the distance between two grid points - by default it is 1 m).

This depends on the setting of tab Curve of the Conveyor class in class library - the Active checkbox must be checked here.

In general, the length dimensions are given by the frame scale: “General®
tab - Scaling Factor.

Scaling Factor determines what the length of 1 pixel is. The default setting
is 0.05 m. The distance between grid lines is 20 pixels. Then the distance
between two grid points is 1 m. If we set the Scaling Factor to 0.5 m, for
example, then the distance between two grid points is 10 m.

On tab Curve, itis possible to set the conveyor’s width and color, width
and color of the ending line, to choose whether the MUs will rotate
according to the direction of the conveyor during animation (Rotate MUSs).

If you do not want to adjust the length according to the layout, deactivate
the Transfer length option.

Computer Simulation of Logistics Processes, SAU, Jan Fabry, 15/03/2023

.Models.Model2.Conveyor

Navigate View Tools Tabs Help

Mame: | Conveyor

Label:

Attributes  Times Failures Controls Exit  Statistics §Curve

Pen width:

Color:
Pen color:
Midline style:

Animate every x-th pixel:

2

2

O Failed
O |Planned

O 0O0OoOood

? X

Entrance locked O

Exit locked O

Energy Cc 9 »

+| Rotate movables [
+| Transfer length  []

Transparent O
Base height: | 1 O m

Segments =

Cancel Apply
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Conveyor creation

Straight segments

Activate the conveyor in the Toolbox (then release the left mouse button again).
Click in the frame on the starting point of the conveyor.

Each new segment is created by another click in the frame.

If we right-click in the frame, we complete the conveyor creation.
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The window Edit Parameters of Curve is automatically opened when dragging the conveyor segment, here we
can fix the tangent angle (e.g., 90° for convenient creation of rectangular segments) or the length of each

segment (e.g., 10 m - each new click will extend the conveyor length by just 10 m) to the fixed value.

LinefArc Parameters

Toolbox

Material Flow | Fluids Resources Information Flow User Interface Mobile Units  User Objects Tools

N Z ) p A mBERCGEHHEmEERES O

EventController
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AngularConverter

Line segments

Arc segments

:

Anchor point height:

Abort

0.000 | m

3.142 ' m

90| °

2\'m

fixed
fixed

fixed
| fixed

| fixed
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Conveyor creation

Arcs

Arcs are inserted by pressing and holding the CTRL key.

In window Edit Parameters of Curve, the lower part of Arc segments is now active:
The tangent angle can be set.
Determine the radius of curvature.
Set the arc length - the calculated central angle is displayed.

If the object is active ("selected"), a right-click will open the context menu, we can add another point, delete the
last segment, etc.

Toolbox .
Material Flow | Fluids Resources Information Flow User Interface Mobile Units User Objects Tools LlnefArC Parameters
O b EBEBCHEEEER=00-E0A ne e
gments
0.000 | m fixed
Arc segments
J——
7.616 | m fixed
3
-43.261 | ©° fixed
10.000 | m fixed
M—
Anchor point height: 1lm
. . .- X P Abort 26
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Attributes

Models.Model2.Station

Each object has a lot of standard attributes such as length, speed, time, T ———
capacity, icon’s name, icon’s number, etc. -

O Failed Entrance locked O

Label: [0 |Planned - Exit locked O

The list of standard attributes and methods can be displayed via the object
context menu in the class library using the command Show Attributes and | Tme SetUp Falues Conrols &t Sttisties Importer Eneray Ce ¢ >

Methods or by activating the object and pressing the F8 key. erocessng time:_[cort | [0710 -
.. . . v| Automatic processing O
In addition, for most of objects there can be assigned any number of R eI .
additional, user-defined attributes. Handling them is the same as handling = recoerytime:  const - [0 0
Standard attrlbutes Recovery time starts: |When part enters - o
Cycle time: Const = |0 O

. 27
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Table of attributes

Names of object attributes start with a capital letter in the list and take on a value while the simulation run, unlike the methods.

Double-click on an attribute line opens a dialog where the value can be changed or assigned. This functionality is not
active for all attributes.

The value of the Inherited / not Is it possible to monitor

attribute or argument inherited value this attribute?

Models.Model2.5tation

ON BEAMEE

Attribute data

Attribute

Name A Value Signature
name addObserver (AttributeName:string, ... type

AssignedLockoutZones [] -> array
assignedWorkplaces [] ([Workplaces:table]) -=...
attributeWatchable (AttributeName:string) -...
AutomaticProcessing true v = boolean
AutomaticSetup true v = boolean
Availability 100.0 real
Capacity 1 v = integer
ChangePathCtrl VOID v method
childMo (Mointeger) -> object
Class MaterialFlow.St... -= object
closeDialog ([ApplyChanges:boolea...
closelmg (ApplyChanges:boolean...
connectAutomatically
ConnectCtrl VOID v method
ConstructorCtrl VOID v method
Cont VOID = -= object
contentsList [1 ([Contents:table]) -= any
Coordinate3D [13.75m, -8.5m... - array
CostingActive false v boolean
createdttr (NameOfUserDefinedAtt...

v createlcon IconMame:string, Widt...

Computer Simulation of Logistics Processes, SAU, Jan Fabry, 15/03/2023 Createln3d true v E,[omean ’ 28

Currlcon "Operational" v = string lz‘
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Thank you for attention

Jan Fabry

Department of Production, Logistics and Quality Management
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